
Digital Solutions Division
Supervisor Guide
May 2005



Publication Information
Toshiba America Information Systems, Inc., Digitial 
Solutions Division, reserves the right, without prior notice, to 
revise this information publication for any reason, including, 
but not limited to, utilization of new advances in the state of 
technical arts or to simply change the design of this 
document.

Further, Toshiba America Information Systems, Inc., Digital 
Solutions Division, also reserves the right, without prior 
notice, to make such changes in equipment design or 
components as engineering or manufacturing methods may 
warrant.

CIX-SG-INSIT-VC.1

Version C.1,  May 2005

© Copyright 2005
Toshiba America Information Systems, Inc.
Digital Solutions Division

All rights reserved. No part of this manual, covered by the 
copyrights hereon, may be reproduced in any form or by any 
means—graphic, electronic, or mechanical, including 
recording, taping, photocopying, or information retrieval 
systems—without express written permission of the publisher 
of this material.

Strata is a registered trademark of Toshiba Corporation. 
Stratagy is a registered trademark of Toshiba America 
Information Systems, Inc.

Trademarks, registered trademarks, and service marks are the 
property of their respective owners.



TOSHIBA AMERICA INFORMATION SYSTEMS, INC. (“TAIS”)
Digital Solutions Division License Agreement

IMPORTANT: THIS LICENSE AGREEMENT (“AGREEMENT”) IS A LEGAL AGREEMENT BETWEEN YOU (“YOU”) AND TAIS. CAREFULLY READ THIS LICENSE AGREEMENT. USE OF ANY 
SOFTWARE OR ANY RELATED INFORMATION (COLLECTIVELY, “SOFTWARE”) INSTALLED ON OR SHIPPED WITH A TAIS DIGITAL SOLUTIONS PRODUCT OR OTHERWISE MADE AVAILABLE TO 
YOU BY TAIS IN WHATEVER FORM OR MEDIA, WILL CONSTITUTE YOUR ACCEPTANCE OF THESE TERMS, UNLESS SEPARATE TERMS ARE PROVIDED BY THE SOFTWARE SUPPLIER. IF 
YOU DO NOT AGREE WITH THE TERMS OF THIS LICENSE AGREEMENT, DO NOT INSTALL, COPY OR USE THE SOFTWARE AND PROMPTLY RETURN IT TO THE LOCATION FROM WHICH YOU 
OBTAINED IT IN ACCORDANCE WITH APPLICABLE RETURN POLICIES. EXCEPT AS OTHERWISE AUTHORIZED IN WRITING BY TAIS, THIS SOFTWARE IS LICENSED FOR DISTRIBUTION 
THROUGH TAIS AUTHORIZED CHANNELS ONLY TO END-USERS PURSUANT TO THIS LICENSE AGREEMENT.

1. License Grant. The Software is not sold; it is licensed upon payment of applicable charges. TAIS grants to you a personal, non-transferable and non-exclusive right to use the copy of the Software 
provided under this License Agreement. You agree you will not copy the Software except as necessary to use it on one TAIS system at a time at one location. Modifying, translating, renting, copying, 
distributing, printing, sublicensing, transferring or assigning all or part of the Software, or any rights granted hereunder, to any other persons and removing any proprietary notices, labels or marks from the 
Software is strictly prohibited except as permitted by applicable law; you agree violation of such restrictions will cause irreparable harm to TAIS and provide grounds for injunctive relief, without notice, 
against you or any other person in possession of the Software. You and any other person whose possession of the software violates this License Agreement shall promptly surrender possession of the 
Software to TAIS, upon demand. Furthermore, you hereby agree not to create derivative works based on the Software. TAIS reserves the right to terminate this license and to immediately repossess the 
software in the event that you or any other person violates this License Agreement. Execution of the Software for any additional capabilities require a valid run-time license.

2. Intellectual Property. You acknowledge that no title to the intellectual property in the Software is transferred to you. You further acknowledge that title and full ownership rights to the Software will remain 
the exclusive property of TAIS and/or its suppliers, and you will not acquire any rights to the Software, except the license expressly set forth above. You will not remove or change any proprietary notices 
contained in or on the Software. The Software is protected under US patent, copyright, trade secret, and/or other proprietary laws, as well as international treaties. Any transfer, use, or copying of the 
software in violation of the License Agreement constitutes copyright infringement. You are hereby on notice that any transfer, use, or copying of the Software in violation of this License Agreement constitutes 
a willful infringement of copyright.

3. No Reverse Engineering. You agree that you will not attempt, and if you employ employees or engage contractors, you will use your best efforts to prevent your employees and contractors from 
attempting to reverse compile, reverse engineer, modify, translate or disassemble the Software in whole or in part. Any failure to comply with the above or any other terms and conditions contained herein 
will result in the automatic termination of this license and the reversion of the rights granted hereunder back to TAIS.

4. Limited Warranty. THE SOFTWARE IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, TAIS AND ITS SUPPLIERS 
DISCLAIM ALL WARRANTIES WITH REGARD TO THE SOFTWARE, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE WARRANTY OF NON-INFRINGEMENT OF THIRD 
PARTY RIGHTS, THE WARRANTY OF YEAR 2000 COMPLIANCE, AND THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS 
TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE IS WITH YOU. NEITHER TAIS NOR ITS SUPPLIERS WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET 
YOUR REQUIREMENTS OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE. HOWEVER, TAIS WARRANTS THAT ANY MEDIA ON WHICH THE 
SOFTWARE IS FURNISHED IS FREE FROM DEFECTS IN MATERIAL AND WORKMANSHIP UNDER NORMAL USE FOR A PERIOD OF NINETY (90) DAYS FROM THE DATE OF DELIVERY TO 
YOU.

5. Limitation Of Liability. TAIS’ ENTIRE LIABILITY AND YOUR SOLE AND EXCLUSIVE REMEDY UNDER THIS LICENSE AGREEMENT SHALL BE AT TAIS’ OPTION REPLACEMENT OF THE MEDIA OR 
REFUND OF THE PRICE PAID. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL TAIS OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, 
SPECIAL, INCIDENTAL OR INDIRECT DAMAGES FOR PERSONAL INJURY, LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION/DATA, OR ANY 
OTHER PECUNIARY LOSS OF ANY KIND ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF TAIS OR ITS SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. IN NO EVENT SHALL TAIS OR ITS SUPPLIERS BE LIABLE FOR ANY CLAIM BY A THIRD PARTY.

6. State/Jurisdiction Laws. SOME STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY MAY LAST, OR 
THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO SUCH LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO YOU. THIS LIMITED WARRANTY GIVES YOU 
SPECIFIC RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE/JURISDICTION TO STATE/JURISDICTION.

7. Export Laws. This License Agreement involves products and/or technical data that may be controlled under the United States Export Administration Regulations and may be subject to the approval of the 
United States Department of Commerce prior to export. Any export, directly or indirectly, in contravention of the United States Export Administration Regulations, or any other applicable law, regulation or 
order, is prohibited. 

8. Governing Law. This License Agreement will be governed by the laws of the State of California, United States of America, excluding its conflict of law provisions.

9. United States Government Restricted Rights. The Software is provided with Restricted Rights. The Software and other materials provided hereunder constitute Commercial Computer Software and 
Software Documentation and Technical Data related to Commercial Items.  Consistent with F.A.R. 12.211 and 12.212 they are licensed to the U.S. Government under, and the U.S. Government’s rights 
therein are restricted pursuant to, the vendor’s commercial license. 

10. Severability. If any provision of this License Agreement shall be held to be invalid, illegal or unenforceable, the validity, legality and enforceability of the remaining provisions hereof shall not in any way 
be affected or impaired.

11. No Waiver. No waiver of any breach of any provision of this License Agreement shall constitute a waiver of any prior, concurrent or subsequent breach of the same or any other provisions hereof, and no 
waiver shall be effective unless made in writing and signed by an authorized representative of the waiving party.

12. Supplier Software. The Software may include certain software provided by TAIS suppliers. In such event, you agree that such supplier may be designated by TAIS as a third party beneficiary of TAIS with 
rights to enforce the Agreement with respect to supplier’s software.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE AGREEMENT AND THAT YOU UNDERSTAND ITS PROVISIONS. YOU AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU 
FURTHER AGREE THAT THIS LICENSE AGREEMENT CONTAINS THE COMPLETE AND EXCLUSIVE AGREEMENT BETWEEN YOU AND TAIS AND SUPERSEDES ANY PROPOSAL OR PRIOR 
AGREEMENT, ORAL OR WRITTEN, OR ANY OTHER COMMUNICATION RELATING TO THE SUBJECT MATTER OF THIS LICENSE AGREEMENT.

Toshiba America Information Systems, Inc.
Digital Solutions Division
9740 Irvine Boulevard
Irvine, California 92618-1697 
United States of America

DSD 020905

5932





Contents

Introduction
Organization.........................................................................................................................v
Conventions ........................................................................................................................vi
Related Documents and Media ......................................................................................... vii

CD-ROMs...................................................................................................................... vii

Chapter 1 – The Grand Tour
Insight Features ....................................................................................................................2
Insight Plus Features ............................................................................................................2
Insight MIS Real Time Client..............................................................................................3

Menu Bar ..........................................................................................................................3
Toolbar..............................................................................................................................4

Wallboards ...........................................................................................................................6
Reports .................................................................................................................................7

Toolbar..............................................................................................................................7
Configurator .........................................................................................................................9

Chapter 2 – Real Time Displays
Create Real Time Displays ................................................................................................11

 Composite Screen Layout..............................................................................................12
Agent Status Window ........................................................................................................14

Create New Agent Status Window.................................................................................14
Configure Agent Status Window....................................................................................14

Real Time Statistics ...........................................................................................................16
Set Real Time Statistics ..................................................................................................16
Insight CIX Supervisor Guide    05/05 i



Contents
Chapter 3 – Reports

ii
Agent Statistics ..................................................................................................................17
Create New Agent Statistics Window ............................................................................17
Configure Agent Statistics Window ...............................................................................18

Wait Time Graph ...............................................................................................................19
Create Wait Time Graph Window..................................................................................19
Change Wait Time Graph Properties..............................................................................20

Calls in Queue Graph (Insight Plus Only) .........................................................................21
Creating Calls in Queue Graph.......................................................................................21
Configuring Calls in Queue Graph .................................................................................22

Large Character Window...................................................................................................23
Create Large Character Window ....................................................................................23
Configure Large Character Window ..............................................................................23
Duplicate Large Character Window ...............................................................................24

Alarms................................................................................................................................24

Chapter 3 – Reports
Report Concepts and Terminology ....................................................................................25

Devices ...........................................................................................................................25
Shifts ...............................................................................................................................27
Types of Reports.............................................................................................................27
Filters ..............................................................................................................................29
Templates........................................................................................................................31
Scheduling ......................................................................................................................31

Reports ...............................................................................................................................32
Event Reports..................................................................................................................32
Traffic Reports for Agents or Extensions.......................................................................33
Traffic Reports for Lines ................................................................................................34
Utilization Reports..........................................................................................................35
Contention Reports (Insight Plus Only) .........................................................................36
Distribution Reports........................................................................................................36
Account Code Reports....................................................................................................38

Forecasting.........................................................................................................................38
Forecasting Report..........................................................................................................39
Forecasting Profile Report..............................................................................................39

Create Report Template .....................................................................................................40
Insight CIX Supervisor Guide    05/05



Contents
Chapter 4 – Wallboards
Edit Report Contents..........................................................................................................41
Filter Report Contents (optional) .......................................................................................43
Create Report .....................................................................................................................44
Export Report.....................................................................................................................45
Using MIS Reports to Improve Performance ....................................................................46

Abandoned Calls and Long Waits ..................................................................................46
Complaints of Busy Signals............................................................................................47
Unexpected Out-of-hours Customer Demand ................................................................48
Complaints About Too Many Transfers .........................................................................48

Chapter 4 – Wallboards
Create Wallboards..............................................................................................................49
Edit Wallboard Items .........................................................................................................53
Automatic Parameter Layout .............................................................................................54
Change Fonts .....................................................................................................................55
Create Wallboard Message ................................................................................................56
Queue Messages.................................................................................................................57

Chapter 5 – Alarms
Configure Alarms...............................................................................................................59

Filtering Alarms..............................................................................................................64
View Alarms ......................................................................................................................65

Glossary .............................................................................................................................. 67

Index ......................................................................................................................................73
Insight CIX Supervisor Guide    05/05 iii



Contents
Chapter 5 – Alarms

iv Insight CIX Supervisor Guide    05/05



Introduction

This guide provides instructions for using the Strata Insight CIX and Insight CIX Plus 
Management Information System (MIS) for call centers.

Organization
This guide is organized as follows:
• Chapter 1 – The Grand Tour covers the basic requirements for Insight and 

Insight Plus. It also provides an overview of the toolbars.

• Chapter 2 – Real Time Displays explains how to create and edit status, statistics, 
graphical, wait time, and large character displays.

• Chapter 3 – Reports details how to create and edit report templates, reports, as 
well as how to filter, compile, print, import and export report data.

• Chapter 4 – Wallboards shows how to configure wallboards, set up schedules and 
messages.

• Chapter 5 – Alarms covers configuring alarms, displaying alarms, and explains 
the various colors and thresholds associated with specific alarms.

• Glossary
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Introduction
Conventions

vi
Conventions
Some of the following conventions are omitted in our manuals when they are not used.

Conventions Description

Note
Elaborates specific items or references other information. 
Within some tables, general notes apply to the entire table 
and numbered notes apply to specific items.

Important! Calls attention to important instructions or information.
“Type” Indicates entry of a string of text.

Select
Instructs the user to choose a menu item or dialog box 
button on the screen.

Represents an icon button on the feature toolbar. When you 
click on this icon, it performs the same function as the step.

Tilde (~) Means “through.” Example: 350 ~ 640 Hz frequency range.

See Figure 10

Grey words within the printed text denote cross-references. 
In the electronic version of this document (Strata Call 
Center Solutions CD-ROM or FYI Internet download), 
cross-references appear in blue hypertext.
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Introduction
Related Documents and Media
Related Documents and Media
Note Some documents listed here may appear in different versions on the CD-ROM, 

FYI, or in print. To find the most current version, check the version/date in the 
Publication Information on the back of the document’s title page.

The following documents and CD-ROMs can be used to reference further information 
about the Insight CIX.
• Strata CIX Call Center Solutions General Description
• Insight CIX inView Quick Reference Guide
• Insight CIX Installation Guide
• Insight CIX Sample Report Guide

CD-ROMs
• Strata CIX Call Center Solutions Application Software and Documentation 

Library for Strata ACD, Insight, OAISYS Net Server, and OAISYS Voice 
Assistant

• OAISYS includes software and documentation for OAISYS Chat, Call Router, and 
Net Phone

For authorized users, Internet site FYI (http://fyi.tsd.toshiba.com) contains all current 
Strata documentation and enables you to view, print, and download current 
publications.
Insight CIX Supervisor Guide    05/05   vii
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   The Grand Tour 1

Insight and Insight Plus is at the heart of a suite of products designed for use in formal 
or informal call center environments. Insight and Insight Plus (an enhanced version) 
consists of the folllowing:

• Insight MIS (see “Real Time Displays” on page 11)
• Wallboards

• Hardware (see “Wallboards” on page 49)
• Software (see Inview Quick Reference Guide)

• Insight Reporter (see “Reports” on page 25 and Insight CIX Sample Report Guide)
• Insight Configurator (see Insight CIX Installation Manual)
The offerings comprise two supervisor offerings (Insight and Insight Plus) and 
inView, a LAN-based package for agents or other staff members.
Both supervisor packages provide user defined real time management displays and 
user defined historical report templates.
Insight and Insight Plus can also be used to drive electronic, LED based wallboards.
Insight systems are Windows-based MIS software programs that work with PCs 
running Microsoft® Windows® 2000 Professional and XP Pro.
Insight CIX Supervisor Guide   05/05 1



The Grand Tour
Insight Features

2

Insight Features
The basic ACD MIS is known as Insight. In addition to the previously described 
general features, Insight also has the following:
• Nine types of real time windows
• Four real time templates created using any number of windows
• Fifteen types of reports that cover a maximum period of one year
• Wallboards
• inView LAN-based displays

Insight Plus Features
As well as the general features described previously, Insight Plus provides the 
following:
• Sixteen different types of real time windows
• Any number of real time templates
• Thirty-four types of reports that cover a maximum period of one year
• Ability to export reports in comma delimited format to spreadsheet packages like 

Excel or Lotus® 1-2-3®, where information can be displayed in graphical format.
• The Insight Plus database can be exported.
• Wallboards
• Sub-supervisors
Insight CIX Supervisor Guide   05/05



The Grand Tour
Insight MIS Real Time Client
Insight MIS Real Time Client

Menu Bar
The Insight Menu Bar provides access to all of its features through the Insight MIS 
program. The software is presented in a Windows format, which is easy to use. The 
following shows the Menu Bar items.

6473

File

View

Setup

Layout

Messaging

Wallboards

Windows

Help

Menu Bar

Snap to Grid
Show Grid
Grid Configuration
New
Copy
Save
Delete

New Real Time Window
Insight Reporter
Insight Configurator
Insight Alarms
Exit

Alarms

Send Message

Configure
Driver

Toolbar
Status Bar
Favorite Layout Bar
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The Grand Tour
Insight MIS Real Time Client

4

Toolbar
The MIS toolbar (shown below) is a component of the real time client. The icons give 
you quick access to Insight commands that are also available through the Menu Bar 
selections.

Icon Menu Option Description

New Real Time 
Window

Enables the user to add a new real tim window to 
the screen layout. See Chapter 2 — Real Time 
Displays for details.

Reporter
Opens the Reporting Package. See Chapter 3 — 
Reports and Insight CIX Sample Report Guide for 
details.

Alarms
The user will pop up the Alarms list for the taskbar 
and inView. See Chapter 5 — Alarms for details.

Messaging

Wallboard messages can be scheduled to appear 
for specific durations. See “Create Wallboard 
Message” and “Queue Messages” on page 57 for 
more details.

Help

Configure
Wallboards

Messaging

Delete Layout
Change Screen
Layout 

Real Time Window Properties

New Real Time Window

Reporter

Configurator

Alarms Window

Save Layout
Copy Layout

New Layout

Copy
Real Time
Window

7777
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The Grand Tour
Insight MIS Real Time Client
Configure Wallboards

Wallboards can be configured to provide real time 
performance statistics and motivational text to call 
center groups.

Insight supports up to six wallboards connected to 
each supervisor position. See Chapter 4 — 
Wallboards for details.

Copy Real Time 
Window

Enables the user to copy an existing real time 
window and add it to the screen layout.

Real Time Window 
Properties

Configure status windows for individual agent 
groups. Groups are created in the Insight 
Configurator (see Insight CIX Installation Guide).

New Layout
Allows the user to create a blank screen and add 
new real time windows using the New Real Time 
Window icon.

Copy Layout
Copies a existing screen layout and enables the 
user to give it a name.

Save
Saves any changes made in the real time screen 
layout.

Delete Deletes an existing screen template.

Configurator
Enables the user to access the Configurator. See 
Insight CIX Installation Guide.

Icon Menu Option Description
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The Grand Tour
Wallboards

6

Wallboards
Wallboards are units that contain lights that display messages to a large viewing area. 
They can be configured by Insight MIS for Insight and Insight Plus to provide real 
time performance statistics and motivational text to call center groups.
Wallboards always include one or more of the following items:
• Label – Displays fixed text used to describe a parameter.
• Message – Displays a scrolling message.
• Parameter – Displays a specific real time data parameter for a specific device or 

device group.
These are combined to form templates and then templates are added to a schedule 
which can then be applied to a specific wallboard.
Insight and Insight Plus support up to six wallboards connected to each supervisor 
position. Insight provides a choice of 45 parameters to display; Insight Plus provides 
over 700 choices. A supervisor can send text messages as well. Audible alarms can 
also be added to alert staff to certain alarm states or messages.
The Insight product line also includes a PC-based LAN application called inView that 
displays agent group statistics and agent status displays on a PC monitor. See the 
Insight CIX inView Quick Reference Guide for more information.
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The Grand Tour
Reports
Reports
While Insight is running, all monitored telephone traffic is logged to the hard disk for 
analysis by the Insight Reporter. To simplify the process of reporting, Insight Reporter 
provides the concept of a “report template” to define the contents of a report. You can 
create any number of report templates. 
A report template is a series of report items used collectively to achieve a desired 
result. For example, a weekly report for Inside Sales may include a Line Traffic 
Report, an Agent Group Traffic Report, or Call Distribution Report as well as any of 
the others available.
Reports can be collated with respect to any number of definable shifts. For example, if 
two sets of agents man the call center at different times during each day of the week, 
then Insight Reporter can generate reports for each shift as necessary. Once collated 
you can either view the report on screen or send a copy to the printer. 

Toolbar
The Reporter toolbar (shown below) is a component of the Insight Reporter program. 
The icons give you quick access to Insight commands that are also available through 
the Menu bar selections.

Insight MIS
Insight 
Configurator

New Report

Open Report Zoom to Width

Zoom to Height

Report Templates
Auto Reports

Auto Report Templates
Help

Print

Export
Report

Save Report 

Page Selection

Zoom Reports

7776
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The Grand Tour
Reports

8

Table 4 below shows the available reports and the individual or group that can access 
them.

Table 1 Insight Reports 

Report
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Event 4 4 4

Traffic X 4 4 4 4 4 X X X X

Traffic Profile 4 4 X 4 4 X X X X

Utilization X 4

Utilization 
Profile 

X 4

Contention 4 4 4

Contention 
Profile 

4 4 4

Wait Time 
Distribution

4 4 4

Wrap-up Time 
Distribution

4 4

Call Time 
Distribution

4 4 4 4 4 4 4 4

Account Code X

Forecast 4 4

Forecast Profile 4 4

X = Appears on Insight and Insight Plus Reports

4 = Appears on Insight Plus Report Only
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The Grand Tour
Configurator
Configurator
The programming in the Configurator is a key element for creating reports. The 
Configurator must mirror the telephone system configuration so that data can be 
collected for each device used in Strata, including Lines, Agents, Extensions, Queues 
and DID Numbers.
The configurations start with a single supervisory position. System option modules 
can be added, including:
• External, wall-mounted electronic reader boards for displaying information to a 

group.
• inView LAN-based PC displays provide information to Agents or Supervisory 

personnel. (See the Insight CIX inView Quick Reference Guide for feature 
instructions.)

• Fully capable sub-supervisors, that allow individual sub-supervisors to control the 
reports and displays needed for their group(s).

The configurations can include database backup capabilities, including collecting data 
and acting as an additional resource for generating reports. For instance, critical 
databases can be stored on a reliable server, such as the server used for backing up the 
organization’s information.
The Configurator window (shown at 
right) enables you to create and edit a 
number of display windows and 
miscellaneous settings. The window 
consists of five tabs, each tab having 
three functions called Edit (individual 
item), Edit Groups, and Edit Super 
Groups. Toshiba recommends 
configuring the items in this order:
1. Agents – Once the common 

definitions are set, you can make 
refinements for specific agents.

2. Agent Groups – By creating the 
Agent groups first, you can set definitions that apply to the entire groups.

3. Agent Super Groups – After the Agent groups and Agents are configured, you can 
create a larger group by configuring a Super Group.

70
73
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The Grand Tour
Configurator

10
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Real Time Displays 2

This chapter covers setting up and interpreting Real Time Displays provided by 
Insight MIS. These displays provide immediate feedback on the activity of your call 
center; they update every second. You can create custom templates using a variety of 
display windows. Standardized colors indicate various alarm states and status 
conditions.
Real Time Displays are configured into templates. A template is a set of display 
windows that can be viewed directly on the screen. Insight supports four user 
definable templates, while the Insight Plus has an unlimited number of templates.

Create Real Time Displays
Real time displays are used to monitor activity in the call center during working hours. 
You will want to determine how many and what type of the following displays you 
would initially like to see. Refer to the table below for display types. 
The following windows are available both in Insight and Insight Plus:
• Agent Group Statistics Window
• Agent Status Window
• DID Group Statistics
• Extension Group Statistics
• Extension Status Window
• Large Character Window (40– Insight, 700 – Insight Plus)
• Line Group Statistics Window
• Line Status Window
Insight CIX Supervisor Guide   05/05 11



Real Time Displays
Create Real Time Displays

12
• Queue Status Window
The following windows are available in only Insight Plus:
• Agent Statistics
• Calls in Queue Graph
• DID Statistics
• Extension Statistics
• Line Statistics
• Queue Group Statistics
• Queue Statistics
• Waiting Time
Real Time templates are saved in a file called misw.ini which can be found in 
c:\Insight\ToshibaCTX\US on the local PC.
This method of configuration allows each client/supervisor to create templates which 
are unique to their own personal needs.
To replicate these templates, simply copy the file from PC to PC.

 Composite Screen Layout
The following figure shows an example of a composite layout with various real time 
display windows. When a layout like this one is saved, you can easily pull up the same 
windows by selecting this layout.
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Real Time Displays
Create Real Time Displays
Indication Colors
On a color monitor, the above windows will show the status of agents and/or devices. 
Insight uses five colors for various alarms and call states.

The call state column will give a text-based indication of the state. Dark gray 
(unavailable) state text descriptions are user configurable via the Configurator while 
the rest are cell fixed.
The following procedures describe how to create and configure Agent Displays. The 
procedures for each type of display are the same. For instance, the procedure to create 
Agent Status Displays is the same for Extension and Line Displays.

Color Meaning Notes

Red Alarm Waiting time threshold exceeded, etc.

Yellow Ringing Device or line is ringing

Blue Busy Agent on call, in wrap up, etc.

Green Idle Agent is idle. Line is free.

Light Gray Device logged off

Dark Gray Unavailable Agent is logged in but not taking calls.

Title

Title

Large Character 
Title

Large
Character 
Display 

Agent 
Statistics
Display

Agent Status
All Non-Sales

Agent Status 
All Sales

Pull-down menu
of Display 
templates

Agent Group 
Statistics 
All Agents 
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Real Time Displays
Agent Status Window

14
Agent Status Window
This window shows the current status of each agent in the selected group. Short 
descriptions of each agent’s status appears with a background color that represents 
various call and/or alarm states. The amount of time that each agent has been in the 
current state is shown. Additional information can be displayed by selecting those 
parameters within the Configuration window.

Create New Agent Status Window

Configure Agent Status Window

1. From the Window menu, click on the New Real Time Window icon.

2. From the New Real Time Window 
screen, select Agent Status, click OK.

1. Right click on the 
Agent Status window 
and select Properties
...or click the Real 
Time Window 
Properties icon.

68
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Real Time Displays
Agent Status Window
2. From Properties for the Agent Status window, enter/select:
• Agent Group
• Agent information to be shown
• Extension information
• Connected to information
• Devices to display
• (Optional) Check Show Extensions in Preference to Agent.

This option always displays the name/number of the extension an agent 
is connected to, even if the agent is logged on at another extension. If 
unchecked, the agent number/name displays.

• (Optional) Check Show Line in Preference to DID.
When checked, this displays the number/name of the line that the agent 
is connected to, even if there is a DID number associated with the line. If 
unchecked, the DID number/name displays.

• (Optional) Check Dialed Digits.
Check this box to display dialed digits for outgoing calls or Automatic 
Number Identification (ANI) or Caller ID (CLID) digits for incoming 
calls.

• (Optional) Check the Bevel option if you want to have a border 
surrounding each row.

• (Optional) Check the Show Active Agents Only option if you want to 
only see logged on agents.

• Select Rows if you wish to see the agents displayed row by row with a 
vertical scroll bar provided to bring non-visible agents into view.

• Select Columns if you wish to see the agents displayed row-by-row in 
multiple columns if necessary. In this case, a horizontal scroll bar is used 
to bring non-visible columns into view.

3. Click OK when done.
The header 4. The header and content font can also be modified by right-clicking on the 

Agent Status window and selecting the appropriate option for the list.
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Real Time Statistics
Statistics can be presented as:
• Interval Call Statistics in which you set the length of time (from 1~1440 minutes) 

that the calculations should cover.
• Daily Call Statistics are based on shift schedules. The counter is reset to zero at 

the beginning of each shift.
Real Time Alarm Thresholds are Real Time Statistics added in the Configurator.

Set Real Time Statistics
Access Real Time Statistics to configure how the interval call statistics and the daily 
call statistics operate. This is a list of the shifts available to use to control the daily call 
statistics. See also Configuring real time call statistics.

1. From the Menu bar, click File > Insight Configurator > Miscellaneous tab > 
Security Groups.
...or click the Configurator icon.

2. Highlight a security group and click Edit. The Security Group Configuration 
screen displays.

3. Click Real Time 
Statistics. The Real 
Time Statistics screen 
displays (shown right).

4. Add new shifts by highlighting a shift from the Available Shift field, then 
click Add
...or remove shifts by highlighting the shift(s), then click Remove.

Note Daily Shifts lists the shifts that are to be used in the Real Time Displays. 
These can be used to provide automatic start and ending times.

63
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Agent Statistics
Statistics based on parameters and time periods that you select will be displayed in the 
Agent Statistics Window.

Create New Agent Statistics Window

1. From the Window menu, 
click on the New Real 
Time Window icon. The 
New Real Time Window 
screen displays. 

2. Select Agent Statistics, 
click OK. The agent 
statistics display 
(example shown right).

3. To change the content or 
header text, right-click and choose the appropriate item for the list.

6810
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Configure Agent Statistics Window

1. Right click on the 
Agent Statistics 
window and select 
Properties. The 
Properties for the 
Agent Statistics 
Window screen 
displays (shown 
right).

2. From the Properties for Agent Group Statistics window, select an Agent 
Group from the drop-down menu.

3. Check an Agent Name Format (numeric, short, long).
4. Select Displayed Parameters by highlighting a parameter from the Available 

Parameter list and click Add
...or highlight a parameter in the Displayed Parameter list and click Remove.

5. Highlight a parameter and click Alternative Label to rename it.
6. Click OK.
7. (Optional) From the Agent Statistics window, click the word Lock at the top 

of the screen to toggle the Agent Statistics window between two display 
modes.
Lock On: Displays the single agent that was left most in the window before 
the lock button was selected. The horizontal scroll bar is removed.
Lock Off: Displays all the agents within the selected agent group and 
provides a scroll bar if there are more agents than can fit in the window.

68
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Wait Time Graph
This is one of the real time data windows that can be added to the Insight real time 
client template.
Each wait time bar graph window shows the wait time for the longest waiting call 
currently queued on a series of Queue and DID Groups and Line, DID, Extension and 
Agent Super Groups.
The graph uses status colors to provide an at-a-glance indication of the status of the 
longest wait time in each queue. If the longest wait time in a given queue exceeds the 
wait time alarm limit for that queue, then the corresponding bar turns red to show how 
much over the alarm threshold the call has been waiting.

Create Wait Time Graph Window

1. Click the New Real Time Window icon.
2. Select Waiting Time Graph from the 

drop-down list and click OK The bar 
graph displays (shown right).
The bar graph can be orientated 
horizontally or vertically. It can also 
be set to auto-scale proportionally for 
the alarm limits configured for the 
displayed parameters. 

36
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Change Wait Time Graph Properties

1. Right click on the Wait Time Graph that you wish to change.
2. Select the desired Wait 

Time Graph, then right 
click on the screen and 
choose Properties. 

3. Select the Name of the Device whose members you wish to monitor.
For example, if you select DID Group, you can monitor the DID numbers 
belonging to the selected group. Whereas, if you choose DID Super Group 
you can monitor DID Groups within the selected Super Group.

4. Select the graph orientation (horizontal or vertical).
5. Enter a bar Width (in pixels).
6. Enter a bar Separation (spacing between bars in pixels).
7. Check the Text In Bar box to display text labels within the bars.

If you choose text in bar, the label size is governed by the bar size. If you 
choose text outside the bar, the label size is governed by the bar spacing.

8. Either check the Autoscale box or enter the maximum number of calls you 
wish the queue graph to display.

9. Choose the axis position (Top/Left, Bottom/Right, or both).
10. Click OK.

6813
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Calls in Queue Graph (Insight Plus Only)
Each Call in Queue Graph window displays bar graphs of the number of calls 
currently queued on a series of queue and DID groups, and line, DID, extension and 
agent super groups. This graph displays real time data and can be placed in the 
composite real time display area (template).
The graph uses status colors so that queue status can be determined at a glance. If too 
many calls are waiting to be answered in a given queue (as defined by the calls 
waiting alarm limit for that queue), the corresponding bar turns red.

Creating Calls in Queue Graph

1. Click the New Real Time Window icon. The New Real Time Window 
displays.

2. Select Calls In Queue Graph from the drop-down list.
3. Click OK. You can configure the contents of 

this window to adjust the size and position of 
the window.

 6
34
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Configuring Calls in Queue Graph
You can configure the Calls in Queue Graph properties: orient the bar horizontally or 
vertically, set the bar width, bar separation, set text in the bar, and scale the bar.

1. Select the New Real Time Window icon. The New Real Time Window 
displays.

2. From the New Real Time window, select Calls in Queue Graph from the 
drop-down list and click OK.

3. Right click on the Calls 
in Queue Graph 
Window that you wish 
to configure and select 
Properties.

4. From the Properties for the Calls in Queue Window, select the Name of the 
Device whose members you wish to monitor.
For example, if you select DID Group, you can monitor the DID numbers 
belonging to the selected group. Whereas, if you choose DID Super Group 
you can monitor DID Groups within the selected Super Group.

5. Select the graph orientation (horizontal or vertical).
6. Enter a bar Width (in pixels).
7. Enter a bar Separation (spacing between bars in pixels).
8. Check the Text In Bar box to display text labels within the bars.

If you choose text in bar, the label size is governed by the bar size. If you 
choose text outside the bar, the label size is governed by the bar spacing.

9. Either check the Autoscale box or enter the maximum number of calls you 
wish the queue graph to display.

10. Choose the axis position (Top/Left, Bottom/Right, or both).
11. Click OK.

68
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Large Character Window
You can create large character windows that display a single parameter for a device or 
group of devices. These windows can display real time status information, such as the 
number of calls waiting to be answered or call statistics information, such as the 
average call wait time. Real time status data is shown with the correct background 
status color. And, both interval and daily call statistics are supported.

Create Large Character Window

Configure Large Character Window

1. From the Window menu, click on the New Real Time Window icon.
2. In the New Real Time Window box, select Large Character, click OK. A 

large character window appears.

1. Right click on the large 
character window that you 
wish to configure and select 
Properties.

2. From the Properties for Large Character Window, enter or select:
• Device Type – Chose the Line, DID, Extension, Agent or Queue, plus 

groups of these devices.
• Device Name – based on the configured names of the device type 

selected.
• Parameter
• Label Text – Enables an integrated text box to indicate the parameter. A 

default is suggested but it can be user configured.

63
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Duplicate Large Character Window

Alarms
Real Time alarm thresholds can be configured to give audible and visual indication of 
a situation that needs management intervention. See Chapter 5 – Alarms for details.

• Hide Window Caption (Optional) – removes the windows title used for 
the display.

• Enable Mouse Drag Window Positioning When Caption Hidden 
(Optional) – Enables you to move the large character window when the 
window caption is hidden.

3. Click OK when done.

1. Click on the Large Character window you wish to duplicate (sample shown 
at right).

2. Click the New Real Time Window icon and the New Real Time window 
displays with the correct selection already highlighted. 

3. Click OK.

Notes

• This is a good technique for creating windows with the same size 
dimensions for a uniform display appearance.

• To change the elements of the duplicate screen, right click the window and 
select Properties.

...or click on the Copy Real Time Window icon and the window will be 
duplicated and can then be edited.
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This chapter provides an in-depth look at the Insight Reporter. The Reporter program 
enables you to collate, view, and print historical reports. This chapter explains how to 
create report templates and how to interpret the report data. Also included are 
instructions for Insight Plus, which enables exporting data that can be imported into 
spreadsheet programs, such as Microsoft Excel®. 

Report Concepts and Terminology
Understanding the key concepts and terminology used with the Reporter is vital to 
understanding the product. The following paragraphs explain these key concepts and 
terms. Also refer to Insight CIX Sample Report Guide.

Devices
Insight refers to lines, DIDs, queues, extensions, agents and account codes as devices. 
Users can create “groups” and “super groups” of devices. A group is simply a 
collection of devices and a super group is a group of groups. Insight Reporter reports 
on:
• Individual devices
• Groups
• Super Groups
To ensure the accuracy of the reports it is vital that the configuration of the telephone 
system is reflected in the programming of Insight. The devices are configured in the 
Configurator. See Table 2 for more information.
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Table 2 Configurator Terms

Lines

In the context of Insight, a line represents either one of your external trunks or Tie 
lines connected to the Strata being monitored. Each line can handle only one 
telephone call at any one time. These calls are denoted as incoming calls 
because the call was originated outside the switch. Strata does not report real 
time status of outgoing calls placed over the monitored lines.

DNIS/DIDs

A Dialed Number Identification Service (DNIS) or Direct Inward Dial (DID) number 
is a dynamic numeric attribute assigned to a line on an incoming call. A DNIS/DID 
call can be routed to groups of extensions/agents or to an individual extension/
agents depending how the call routing software within the Strata has been 
programmed. If configured correctly, Insight can monitor in real time and 
historically the activity of inbound calls associated with DNIS/DID numbers.

Queues
A Strata extension that provides a holding position (queue) for calls waiting for an 
available agent. 

Extensions

An extension is the physical telephone handset where an agent can receive 
incoming calls, make outgoing calls or handle other forms of internal telephony 
traffic. Within the Strata systems, an extension is reported like an Agent. Thus the 
reports available for Extensions look very similar to those reported for an Agent 
except an Extension does not have the ability to log in or out.

Agents

An agent is the telephone operative who handles calls at an extension. Agents are 
identified by an Agent ID Code they use at the extension to enable call center 
telephony routing facilities within the switch. The Agent ID must uniquely identify 
the agent for Insight to give meaningful statistics concerning the activity of 
individual agents.

Account 
Codes

While on a call, agents can enter account codes that describe the nature of the 
call. Up to 15 account code digits can be entered, but Strata only reports the first 
two digits to Insight for reporting. The Strata allows up to 100 account codes to be 
entered and up to 20 account codes can be entered per call. Insight Reporter 
provides analysis of account code usage.
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Shifts
Reports are compiled based upon shifts that are defined in the Configurator. These are 
used to filter the collected data to those times the user is interested. Real working 
shifts are used to create reports; however, shifts can also be used to determine what 
happens outside normal working hours, or certain days of the week, or just during 
certain hours (e.g., lunchtimes). For example, you can create a report over a six-month 
period that only reports the activity on Mondays.

Types of Reports
This section defines the types of reports available for the user. The terms used on the 
reports are explained in the Glossary.
Any number of report templates can be created and stored for later use. The contents 
of these templates are stored in a file called misreptr.ini which can be found in 
C:\Insight\ToshibaCTX\US on the local PC.
This method of configuration allows each client/supervisor to create templates which 
are unique to their own personal needs.
To replicate these templates, simply copy the file from PC to PC.
The following reports are available both in Insight and Insight Plus:
• Account Code Report
• Agent Group Traffic Report
• Agent Traffic Report
• Agent Utilization Profile Report
• Agent Utilization Report
• DID Group Traffic Profile Report
• DID Group Traffic Report
• Line Group Traffic Profile Report
• Line Group Traffic Report
• Queue Super Group Traffic Report
• Queue Group Traffic Profile Report
• Queue Group Traffic Report
• Queue Traffic Profile Report
• Queue Traffic Report
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The following reports are only available in Insight Plus:
• Agent Event Report
• Agent Group Traffic Profile Report
• Agent Traffic Profile Report
• Contention Profile Report
• Contention Report
• DID Traffic Profile Report
• DID Traffic Report
• Extension Event Report
• Extension Group Traffic Profile Report
• Extension Group Traffic Report
• Extension Traffic Profile Report
• Extensions Utilization Profile Report
• Extension Utilization Report
• Forecasting Profile Report
• Forecasting Report
• Line Group Event Report
• Line Traffic Reports
• Wrap Time Distribution Report
• Call Time Distribution Report
Note You cannot Save reports or Export Data in Insight, only in Insight Plus. 
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Filters
The standard items that make up a report template tend to analyze your call center 
from one point of view only. For example, consider the DID Traffic Report and the 
Agent Traffic Report. These two reports analyze DID traffic and the associated agent 
traffic in isolation. 
What if your call center is set up to route a series of DID numbers to the same group of 
agents? To obtain the performance of each agent on a per DID basis you need to attach 
report filters to the report items. In this example you could either create a series of 
DID traffic reports, each filtered to a different agent, or you could create a series of 
agent traffic reports each filtered to a different DID number.
A report filter is made up of a logical combination of filter elements. Each report item 
within a report template can have a different report filter attached to it if necessary.
A typical report using filters is an Abandoned Call Report. Abandoned Calls are 
shown in a Line or Line Group Report. Adding a filter for one or more Queues, show 
Abandoned Calls for that group(s). Table 3 shows the filter elements that are 
supported.
Note Filters can only be applied to the opposite end of the call path. For example, if 

an agent side report is being used valid filters would include Lines, DIDs, 
Queues, Dialed Digits and Account Codes but not Agents.

Table 3 Report Filters 

Filter Only accepts calls that were:

Line Connected to a specific line.

DID Associated with a specific DID number.

Queue Device in the switch that the ACD software uses to route calls correctly.

Extension Connected to a specific extension.

Logged on Ext. Taken by an agent logged on at the specified extension.

Agent Connected to a specific agent.

Account Code Attached to a specific account code 

Line Group Connected to lines within a specified line group.
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DID Group Associated with DID numbers within a specified DID group.

Queue Group

Collection of queues monitored by the Insight MIS. Queues can belong 
to multiple queue groups if necessary. For each queue configured in the 
system you can make one of the groups that it belongs to its default 
group. 

Extension Group Connected to extensions within a specified extension group.

Logged on Ext. Grp
Taken by an agent logged on at an extension in the specified extension 
group.

Agent Group Connected to agents within a specified agent group.

Account Code Grp Attached to an account code within a specified account code group.

Ext. Queue Grp
Inbound and finally queued to a specific extension group corresponding 
to the Strata (EG501 ~ EG516).

Queue Inbound that ended up on a specific queue.

Dialed Digits 

Had inbound/outbound dialed digits that match a specified string. 

Note The character * may be used at any point to denote that the filter 
will accept dialed digit strings which are identical up to that point 
but differ afterwards.

Table 3 Report Filters (continued)

Filter Only accepts calls that were:
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Templates
Individual reports are grouped together to form a template. Templates are created by 
the user to provide relevant information for the selected devices to be monitored. 
Report items are added to a template to create all the information desired. These report 
items can also be configured by the user to include or exclude certain event or traffic 
types. Once a report template is created, a report for a given time period can be created 
by selecting the template, work shift, starting time, and ending time for the report. 
Keep in mind that Event Reports are highly detailed and therefore it is unlikely that 
you would want to run this report over long periods of time. Similarly, Profile Reports 
that are suitable for daily use (say with hourly resolution) would not make sense if the 
report were being compiled over a six-month time frame. This being the case you will 
be advised to create many templates all designed for specific use and each containing 
appropriate report items.

Scheduling
Once the Templates have been made, the final step is to make a schedule to create and 
print the information. This scheduling is totally optional for the user.
The user can schedule report collation only, collate and print or collate, print and then 
close after printing. Insight Plus users can also schedule Export and Save.
Note File names remain the same after each automated Export or Save process so, 

unless the reports previously Exported or Saved, are moved, they are 
overwritten.

The Scheduling process is client based and so the client PC and Reporter application 
must be running for the process to be carried out.
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Reports
Having established the type of report you need, use this section to help chose exactly 
the right report for your needs. This section describes what kind of reports are 
available. Actual reports are explained in Insight CIX Sample Report Guide.

Event Reports
There are three types of event reports, each recording all events that occur on the 
specified device (agent, extension or line group). Events are caused by the device, 
such as an agent, receiving an incoming call, accepting a call, dialing an intercom or 
outgoing call etc.
Agent or extension reports show exactly what an individual device has been doing 
over the period by examining all events caused by the device’s activities. The report is 
presented in a call event per row format. Pagination of the report occurs if either there 
are too many call events to fit in the height of a page or there are too many statistics 
parameters to fit in the width of a page. 
A line group event report provides an event/call trace for a selected line group. You 
can select the call types in which you are interested, for example, incoming, outgoing 
or abandoned calls. For example to see a list of all abandoned calls the call center 
experienced, compile a line group event report for all lines, selecting abandoned calls 
only. 
This report can be useful in finding out the Calling Line Identity (CLID) of the 
customers who abandoned so their calls may be returned. The report is presented in a 
call event per row format. Pagination of the report occurs if either there are too many 
call events to fit in the height of a page or there are too many statistics parameters to 
fit in the width of a page.
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Traffic Reports for Agents or Extensions
There are four different report types available on the Insight for traffic reporting on 
agents or extensions:
• Agent/Extension Traffic Report – provides a breakdown of the traffic for 

individual agents within an agent group. An agent/extension traffic report provides 
historical call statistics data for each device within a selected group. The report is 
presented in an agent/extension per row format with a “totals” entry for the whole 
group being presented at the bottom of the report. Pagination of the report occurs if 
either there are too many devices to fit in the height of a page or there are too many 
statistics parameters to fit in the width of a page.

• Agent/Extension Traffic Profile Report – provides a profile of traffic information 
for an individual agent over a number of time periods.
An agent/extension traffic profile report provides historical call statistics data for a 
selected device presented in a series of uniform time bands. The interval time 
governing the time bands can be anything from one minute up to 999 weeks. 
The report is presented in a time band per row format. Pagination of the report 
occurs if either there are too many time bands to fit in the height of a page or there 
are too many statistics parameters to fit in the width of a page.

• Group Traffic Report – provides a breakdown of traffic information for all agent 
groups within an agent super group (group of groups), such as “All Agents.”
An agent/extension group traffic report provides historical call statistics data for 
each agent group within a selected agent/extension super group. The report is 
presented in a device group per column format. Pagination of the report occurs if 
either there are too many groups to fit in the width of a page or there are too many 
statistics parameters to fit in the height of a page.

• Group Traffic Profile Report – provides a profile of traffic information for an 
agent group, such as “Sales” or “Support,” over a number of time periods.
An agent/extension group traffic profile report provides historical call statistics 
data for a selected agent/extension group presented in a series of uniform time 
bands. The interval time governing the time bands can be anything from one 
minute up to 999 weeks. 
The report is presented in a time band per column format. Pagination of the report 
occurs if either there are too many time bands to fit in the width of a page or there 
are too many statistics parameters to fit in the height of a page.
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Traffic Reports for Lines
There are five different report types available on Insight for traffic reporting on DNIS/
DID numbers and three report types for lines:
• Line/DID Traffic Report – provides a breakdown of the traffic information for 

individual Lines/DIDs within a group.
A Line/DID traffic report provides historical call statistics data for each line or 
DID number within a selected group. The report is presented in a line/DID per row 
format with a “Totals” entry for the whole group being presented at the bottom of 
the report. Pagination of the report occurs if either there are too many devices to fit 
in the height of a page or there are too many statistics parameters to fit in the width 
of a page.

• Line/DID Group Traffic Report – provides a breakdown of traffic information 
for all groups within a Line/DID super group (group of groups), such as “All 
Lines” or “All DIDs.”
A Line/DID group traffic report provides historical call statistics data for each DID 
group within a selected super group. The report is presented in a group per column 
format. Pagination of the report occurs if either there are too many groups to fit in 
the width of a page or there are too many statistics parameters to fit in the height of 
a page.

• Line/DID Group Traffic Profile Report – provides a profile of traffic 
information for a Line/DID group, such as “Sales DIDs” or “Support Lines,” over 
a number of time periods.
A Line/DID group traffic profile report provides historical call statistics data for a 
selected group presented in a series of uniform time bands. The interval time 
governing the time bands can be anything from one minute up to 999 weeks. The 
report is presented in a time band per column format. Pagination of the report 
occurs if either there are too many time bands to fit in the width of a page or there 
are too many statistics parameters to fit in the height of a page.

For each of these reports, to configure the statistics analysis thresholds that control the 
calculation of the Grade of Service (GOS) refer to “Configuring DID groups or 
Configuring lines” in the help file.
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Utilization reports apply to agents and extensions and are available in two formats: 
standard and profile. There are four utilization reports in all.
An agent or extension utilization report provides historical time utilization data for 
each agent or extension within a selected group. Note that the times are shown as a 
percentage normalized to the shift that you collated the report with. The report is 
presented in an agent per row format with a “totals” entry for the whole group being 
presented at the bottom of the report. 
Pagination of the report occurs if either there are too many agents to fit in the height of 
a page or there are too many statistics parameters to fit in the width of a page. 
Utilization percentages can be calculated with respect to either the total reporting 
period or the amount of time each agent had spent logged on.
Note The “totals” entry for each column is the average for all agents/extensions in 

the group.
An agent utilization profile report provides historical time utilization data for a 
selected agent presented in a series of uniform time bands. The interval time 
governing the time bands can be anything from one minute up to 999 weeks. The 
report is presented in a time band per column format. Pagination of the report occurs if 
either there are too many time bands to fit in the height of a page or there are too many 
statistics parameters to fit in the width of a page.
Utilization percentages can be calculated with respect to either each profile interval or 
the agent/extension logged on time with each profile interval.
Note The times shown are a percentage normalized to the shift that you collated the 

report with.
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Contention Reports (Insight Plus Only)
Contention reports are available as standard or profiled over flexible time periods.
A standard contention report provides the percentage of time a variable number of 
members in a group were simultaneously free/busy. The statistics are presented either 
as non-cumulative or cumulative.
• Non-cumulative - Each line of the report gives the percentage of time that exactly 

that number of members were free.
• Cumulative - The first line of the report gives the percentage of time zero 

members were free. The second line gives the percentage that up to one member 
was free. The third line gives the percentage that up to two members were free and 
so on until the number of members in the group or Max Items has been reached.

A series of either line groups, extension groups, or agent groups can be analyzed 
within a single report. The report is presented in a group member per row format. 
Pagination of the report occurs if either there are too many group members to fit in the 
height of a page or there are too many groups to fit in the width of a page.
A contention profile report provides historical time data for the percentage of time a 
variable number of members in a group were simultaneously free/busy. The statistics 
are presented either as non-cumulative or cumulative. 
A single report can analyze a line group, an extension group, or an agent group. The 
report is presented in a time band per column format. Pagination of the report occurs if 
either there are too many time bands to fit in the height of a page or there are too many 
statistics parameters to fit in the width of a page.

Distribution Reports

Wait Time (DID Super Group, DID Groups, Lines Super Group)

A wait time distribution report provides the number of calls and percentage of calls 
whose wait time fell within a series of user configurable time bands. 

The report can analyze the waiting time distribution for:
• Answered Calls
• Abandoned Calls 
• Or Both 
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The report is presented in a wait time band per row format. Pagination of the report 
occurs if either there are too many time bands to fit in the height of a page or there are 
too many groups/DID numbers to fit in the width of a page. The reports are available 
as ACD only, non-ACD only or both on the same report.

Wrap-up Time (Agent Groups, Agent Super Groups)

A wrap-up time distribution report provides the number of calls and percentage of 
calls whose wrap-up time fell within a series of user configurable time bands. 
• Incoming Calls 
• Outgoing Calls. 
• Intercom Calls (Agents, Extensions, Agent Groups, and Extension Groups only)
• Any combination of above.
The report is presented in a wrapup time band per row format. Pagination of the report 
occurs if either there are too many time bands to fit in the height of a page or there are 
too many groups/agents to fit in the width of a page.The reports are available as ACD 
only, non-ACD only or both on the same report.

Call Time (All Types)

A call time distribution report provides the number of calls and percentage of calls 
whose call time fell within a series of user configurable time bands. The report can 
analyze the call time distribution for:
• Incoming Calls 
• Outgoing Calls. 
• Intercom Calls (Agents, Extensions, Agent Groups, and Extension Groups only)
• Any combination of above.
The report is presented in a call time band per row format. Pagination of the report 
occurs if either there are too many time bands to fit in the height of a page or there are 
too many groups/members to fit in the width of a page.
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Account Code Reports
An account code traffic report provides historical call statistics data for each account 
code within a selected account code group. The reports are available as ACD only, 
non-ACD only or both on the same report.
The report is presented in an account code per row format with a “totals” entry for the 
whole group being presented at the bottom of the report. Pagination of the report 
occurs if either there are too many account codes to fit in the height of a page or there 
are too many statistics parameters to fit in the width of a page.

Forecasting
The Forecasting feature includes:
• Forecasting Report
• Forecasting Profile Report
• Forecasting Modifications
• Managing Historical Reports
The forecasting package is designed to enable the user to perform what if scenarios on 
the historical data. This is achieved as follows:
Over a period the following parameters are calculated:
• The total number of incoming calls.
• The average incoming call time (including held time, but excluding wrapup time) 

on the line side of the call.
• The average waiting time of an incoming answered call on the line side.
• The number of available agents.
• The average wrapup time per incoming call.
• The average amount of time each agent spent unavailable excluding wrapup time.
You then may specify a series of modifications to be performed on the above 
parameters.
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A forecasting report calculates the actual number of calls, average call time, average 
wait time and number of available agents over a specified time period using specified 
line and agent groups. It then provides an estimate of how one of these parameters 
would vary depending on specific modifications made to the other three. The specified 
modifications can be applied individually - resulting in a series of estimates, or they 
can be applied collectively - resulting in a single estimate.

Note The results produced by the forecasting package are calculated from a set of 
rules that may not apply perfectly to every site. While every effort has been 
made correct these figures on a site-by-site basis, the results should be used for 
indication purposes only.

Forecasting Profile Report
A Forecasting Profile Report calculates the same type of information as a Forecasting 
Report, except that it can cover a single time band or an interval which includes 
several time bands in a single estimate.
Like the Forecasting Report, the Forecasting Profile report calculates the actual 
number of calls, average call time, average wait time and number of available agents 
over a series of uniform time bands using specified line and agent groups. It then 
provides an estimate of how one of these parameters would vary depending on 
specific modifications made to the other three. 
The specified modifications can be applied individually, resulting in a series of 
estimates per time band, or they can be applied collectively, resulting in a single 
estimate per time band. The interval time governing the time bands can be anything 
from one minute up to 999 weeks.
The report is presented in a time band per column format. Pagination of the report 
occurs if either there are too many time bands to fit in the width of a page or there are 
too many modifications to fit in the height of a page.
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Create Report Template
Report templates define the look and content data included in a report. You can use 
any of the default report templates or create custom templates that can be used over 
and over. The steps show how to create a custom template.
Note To further refine the report content, also see “Filter Report Contents (optional)” 

on page 43.

1. From the Reporter toolbar, click on the Report Template icon
...or select Set-up, Report Templates per the Menu bar.

2. Type a new template name over 
the existing name.
This is the template file name. The 
name that appears on the printed 
report is entered later, in Step 3.
From the Report Templates, you 
can create/edit templates: Add, 
Change, Delete, Rename

Note The Change button turns into the Add button when you type a new 
template name.

3. Click Add and the Configure 
Report Template screen 
displays (shown right). Type 
the report title in the Print 
Name box and click OK.

64
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...or click Change and the Configure Report Template screen displays. 
Highlight a Report Name and click one of the buttons to the right (e.g., Edit 
Item) to make your change. Click OK.
...or click Delete, then select the name of a template to delete. A dialog box 
displays asking you to confirm the deletion.
...or click Rename. From Rename Report Template, type in a New Template 
Name and click OK.

4. Click Close.

1. From the Reporter toolbar, click Report Templates.
2. From Report Templates, select the template from the drop-down menu and 

click Change.
3. Select the Report Item you wish to change 

and click Edit Item. The Configure Report 
screen displays (sample shown at right).

4. From the Configure Report dialog box:
• Select the Agent Group from the pull-

down list
• Select Agent Number, Name or Both
• Select any of Total: Calls, Time, 

Usage
• Select Calls: Answered, Transferred, 

RNA, Intercom, Outgoing
• Select Performance: Calls, 

Availability, Call Rate 35
45
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The Call Rate is the number of calls taken/made per hour by an agent. 
However, the time that the agent is logged on is taken into account to 
give a more accurate figure. The Call Rate is then worked out by 
dividing the number of calls by the time logged on.
Call Rate = Total Number of Calls

                                Time Logged On
• Display Total Times shows total call time instead of average
• Exclude Unused Agents removes inactive agents for the report
• Include Talk Time includes a column separating talk time from total call 

time
5. To add a filter, go to Filter Report Contents (optional)

...or click OK to save the changes.
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Filter Report Contents (optional)
Filtering is how to selectively determine the content of a report. The Configure Report 
window contains checkbox selections that indicate the data to be included. These 
items are defined in the Reports Glossary or the user guide glossary. We suggest that 
you create various reports selecting different Report Items and data to determine 
which combination works best for you.

1. From the Configure ... Report 
screen, click Filter. The 
Report Filter screen displays 
(shown right).

2. Click Add Element. The Add 
Filter Element screen 
displays (shown right).
...or highlight a Filter 
Element in the list and click 
Delete Element or Edit 
Element.

3. If you selected Add Element, a Add Filter Element screen displays and you 
need to select the type of element to be used from the drop-down menu.
...or if you selected Edit Element, a Edit Account Code Filter Element 
screen displays and you need to select an account code name from the drop-
down menu.
...or if you selected Delete Element, the element is deleted.
Hint: It is helpful to rename filtered files so that you can identify which filter 
has been applied to it.

4. Click OK.

64
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Create Report
If you have a color printer, Insight Reporter can produce color printouts.

 

Figure 1 Sample Agent Traffic Report

1. From the Menu bar, select File > 
New
...or click on the New Report icon. 
The Request a New Report screen 
displays (shown right).

2. Select the time period the report will cover (Start and Stop Times), the 
Report Shift and the report template.

Note The available Report Shifts are created from Configure Shift window. See 
the Insight CIX Installation Guide for more details about creating and 
editing shifts.

3. Click OK. The report should be compiled in a few minutes. A sample report 
is shown in Figure 1.

4. You can now print, save (Insight Plus only), export (Insight Plus only), or 
close the screen.

63
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Report information can be saved in comma delimited ASCII format that can be 
imported into most commercial spreadsheet and database programs. Plain text fields 
are exported in double quotes.
• Integers are exported without quotes.
• Floating point number, such as averages, are exported without quotes with three 

decimal places.

Important! The Report you want to export must be displayed on the screen for 
the Export function to be active.

1. From the Reporter 
toolbar, click on the 
Export icon
...or from the Menu bar, 
click File > Export. The 
Export as screen 
displays (shown right).

2. In the Save in field, select a directory/file where you want the file saved.
3. In the File name field, type a file name or select the default.
4. In the Save as type field, you must select the default of Insight Export Files 

(*.txt).
5. Click Save.
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Using MIS Reports to Improve Performance
This section deals with some of the potential problems identified using the reporting 
package and possible solutions to those problems. As with many things there could be 
a number of ways to improve performance and increase productivity so you may need 
to try different things to see which work the best.

Abandoned Calls and Long Waits
You may identify a problem of long waits and too many abandoned calls. Here are 
some solutions to this problem:

Solution A – Use Recorded Announcements and Music

Using methods for keeping the caller waiting is usually one of the first methods 
employed to handle the callers. This can be accomplished using the recorded 
announcement facilities. Well worded messages played to callers in the queue have 
proved to be very successful. Avoid repeating the same message over and over and 
consider playing music or other recorded information between greetings.

Solution B – Restrict Outbound Activity

If your staff make outgoing calls at the same time as they receive inbound calls, 
consider restricting the outbound activity to a less busy time of day. Use Profile 
Reports to identify the peak hours and the quietest times of the day.

Solution C – Overflow Calls to Other Staff Members

Consider overflowing calls to other members of staff in other areas of the business. 
Although this could be less than ideal it could eliminate the lost order or lost customer. 
Research has shown that 60% of callers who abandon do not call back.

Solution D – Introduce Headsets

If you do not use headsets, consider introducing them. Headset use will speed up calls 
whenever keyboard work is involved. Headsets could also permit the use of the auto 
answer feature on Strata. This speeds up the call process and reduces noise and stress 
in the call center. 
Insight CIX Supervisor Guide   05/05



Reports
Using MIS Reports to Improve Performance
Solution E – Use Profile Reports to Identify Staffers Needs

Use Profile Reports to identify peaks and valleys in terms of activity. Rarely will the 
level of traffic be constant. Having identified the peak hours consider changing the 
working hours of staff and maybe consider part time employees.

Complaints of Busy Signals
Use the Contention or Contention Profile Report to identify the size and timing of the 
problem. Caution should be used before rushing out and adding more lines, even 
though they may be relatively inexpensive. The additional lines could result in periods 
where callers go unanswered if the staff available is not adjusted to take more calls.

Solution A – Add More Lines

Assuming you have staff available to answer the extra volume, add more lines to your 
system.

Solution B – Restrict Outbound Activity

If your staff make outgoing calls at the same time as they receive inbound calls 
consider restricting the outbound activity to a less busy time of day. Use Profile 
Reports to identify the peak times and the quietest times.

Solution C – Reduce Call Duration

Find out if it is possible to reduce the duration of calls. If you can achieve this without 
reducing the quality of service then this will enable you to answer more calls with the 
same number of lines and people. Call duration is the time spent on the call plus the 
wrap-up time allocated for the end of the call. Before embarking on a call time 
reduction campaign consider the profile of the best agent. You might want to consider 
training your staff to the performance level of this agent.

Solution D – Check Out Wrap-up Time

Check out the wrap-up time associated with telephone calls. If the time is excessive, 
find out why. It could be, for example, that quotations have to be sent out. Perhaps 
faxing from the PC could speed up the process thereby increasing the volume of calls 
that can be handled. 
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One client established that the average time spent in wrap-up of an order took over ten 
minutes because the sales agent had to print off an order confirmation and take it to 
the mailroom for processing. Now the printer is located in the mailroom and wrap-up 
time is reduced by 75%.

Unexpected Out-of-hours Customer Demand
Using the out-of-hours shift for reports, you can establish if there is a demand for your 
services when you are closed.
Using Profile Reports, identify the demand and the timing. Consider opening at this 
time to handle calls. If this is not possible, consider giving callers the option to leave a 
message to be dealt with as a priority when you start work. The third option could be 
to overflow to a bureau. In all cases, it is recommended that an out-of-hours message 
be played apologizing for the fact you are closed, stating your opening times and 
advising of available alternatives, if there are any.
To measure call activity, out of hours calls must be presented to devices on the CIX 
that are monitored by the ACD Server. These include RAN devices, etc.

Complaints About Too Many Transfers
You may have customers who complain their call gets passed around the organization 
before they get the person who can deal with their problem.
Use the Agent Traffic Reports to identify the agents who transfer callers the most and 
then the Event Reports to find out the details. This could indicate needed training for 
those agents in the skills and knowledge of handling calls themselves. Inquiry calls 
could also indicate a similar problem. 
If high proportions of calls are transferred because they are not dealt with by the 
receiving department, consider other methods of routing the calls into the correct 
department without human intervention. This could include using DID numbers to 
route calls into appropriate departments. This is ideal if you are in a position to 
educate your callers. 
The ideal caller here would be a field employee, employees at other locations and 
customers. Another idea would be to answer all calls with an Auto-Attendant (AA) 
and make the user select from a menu. The AA would then route the call according to 
the selection made.
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Create Wallboards
Each Insight MIS work station can drive up to six wallboards simultaneously via one 
serial port connection.

Step 1: Select Wallboard Serial Port

Step 2: Configure Wallboard

1. From the Menu bar, select 
Wallboards > Driver. The 
Wallboard Driver screen 
displays (shown right).
...or from the toolbar select 
the Wallboard icon.

2. Select the wallboard type, the appropriate Serial port, and for some 
wallboard types the Baud Rate. Spectrum Wallboards are the only ones 
supported in the United States.

3. Click OK.

1. From the Wallboard Configuration window, click Configure.
Note Only the selected wallboard number can be configured. Each wallboard 

must be selected by number and configured individually.
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Step 3: Create Wallboard Template
Templates define the text size and the placement of information on the wallboard. 
They also define the type of real time parameters and text scrolling. You can create as 
many wallboard templates as you want.

2. Delete any schedule that 
you do not need by 
highlighting it and 
clicking Delete 
Schedules.

3. Verify Fitted is checked 
(at bottom of screen).

Important! If the Fitted 
field is not 
checked, the 
wallboard will not work

1. From the Menu bar, select Wallboard > 
Configure
...or click the Configure Wallboards icon. The 
Wallboard Configuration screen displays 
(shown right).

2. Click Templates. The Wallboard 
Templates screen displays (shown 
right).

3. Type a new template name over the 
existing name.

Note The Change button turns into the 
Add button when you type a new 
template name.

64
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4. Click Add. The 
Configure Wallboard 
Template displays 
(shown right).

5. Click Add Item. The Add Wallboard 
Template Item screen displays 
(shown right).

6. From the Item field, select Label, Message or Parameter and click OK. The 
item is added to the Configure Wallboard Template screen.

7. Under Automatic Parameter Layout, click 1, 2, or 4 to automatically define 
the position and width of the labels and parameters in the template. See 
“Automatic Parameter Layout” on page 54 for details on using this option.
...or manually configure the position, size and/or justification of each 
parameter. See “Edit Wallboard Items” on page 53 for details.

8. Click OK > Close. The Wallboard Configuration screen displays.

6388
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Step 4: Create Wallboard Schedule
The next step is to create a schedule for displaying the templates. A wallboard 
schedule essentially defines the sequence in which the templates should display. At 
the end of the sequence, the scheduled sequence starts over. You can create as many 
schedules as you want to manage the wallboards.

1. From the Wallboard Configuration 
screen, click Schedules.

2. Type a new schedule name.
Note The Change button turns into the 

Add button when you type a new 
template name.

3. Click Add. The Configure 
Wallboard Schedule screen 
displays (shown right).

4. Click Add Template to view the 
templates. The Add Wallboard 
Template screen displays (shown 
right). Select one of the 
Templates from the drop-down 
menu.

Note See “Step 2: Configure Wallboard” on page 49 to Delete or Change 
Template(s).

5. Enter the wallboard template duration.
6. When scheduling is complete, click OK twice, then click Close.
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1. From the Menu bar, select Wallboard > Configure

...or click the Configure Wallboards icon. The Wallboard Configuration 
screen displays.

2. Click Templates. The Wallboard Templates screen displays. 
3. Select the Wallboard from the drop-down menu.
4. Click Change. The Configure Wallboard Template displays.
5. Highlight an item in the list and click Edit Item.
6. If you selected a label to edit, the 

Configure Wallboard Label screen 
displays (shown right). Type the name of 
the label in the Label field, select its 
position (row, col.) and its font size 
(small, large). Click OK.

Note  All items on a wallboard must have 
the same size font.

The revised label displays in the 
Configure Wallboard Template list.
...or if you selected a parameter 
to edit, the Configure Wallboard 
Parameter screen displays 
(shown right). From the drop-
down menus, select the Device 
Type, Device Name and 
Parameter. Select a position 
(row, col., width in digits), 
justification (left, center, right) 
and font size (small, large). 
Click OK. 

Note  All items on a wallboard 
must have the same size font.

The revised parameter displays in the Configure Wallboard Template list.
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Automatic Parameter Layout
When adding parameters and labels to a wallboard template, you need to define the 
position and width of these items on the wallboard display. To avoid this process, 
Insight MIS provides three automatic layouts—1, 2, and 4—on the Configure 
Wallboard Template screen.

1. Using the Add Wallboard Template Item screen, add into the template the 
parameters you wish to display.

2. From the Configure Wallboard Template screen, based on how many 
parameters you added in Step 1 click 1, 2 or 4 in the Automatic Parameter 
Layout section of the screen.
The parameters are arranged in one line, two lines or four quadrants 
according to the option you chose. Labels are automatically inserted where 
possible for the parameters.

3. Click OK when done.
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There are two sizes of fonts for wallboards. 
• Small – Depending on the wallboard, up to one or two rows of characters can be 

displayed. This size works well with real time performance information, since it 
allows up to six parameters to be shown.

• Large – One row of large text can be displayed. Large text is good for scrolling 
messages.

1. From the Menu bar, select Wallboard > Configure
...or click the Configure Wallboards icon. The Wallboard Configuration 
screen displays.

2. Click Templates. The Wallboard Templates screen displays. 
3. Select the Wallboard from the drop-down menu.
4. Click Change. The Configure Wallboard Template displays.
5. Click Edit Item and the 

Configure Wallboard Parameter 
screen displays (shown right). 

Note All items on a wallboard must 
have the same size font.

6. Select Small or Large.
7. Click OK to exit out of this screen.
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Create Wallboard Message
An agent can send a message of up to 256 characters to any other Agent(s) or all the 
Agents in any other Security Group(s) depending on his or her Message Access Level. 
Note The same message can also be sent to any of the wallboards at the same time as 

well as inView, if it is used.
Wallboard messages can be scheduled to appear for specific durations. 

1. Select Messaging > Send 
Messages
...or select the Send 
Messages icon.

2. Type your message in the Message field.
3. Click Add under Message Library if you want to add it to the message 

database library. The message is added as a selection to the drop-down menu 
in the Message field and can be quickly recalled whenever required.
At a later time, the message can be deleted from the library by clicking on 
Delete.

4. Select the priority for the message — normal or high (only inView supports 
priority).

5. If using inView, highlight the Agents you want to send the message to or 
highlight a security group to send it to all the Agents in that group.

6. If using the external wallboard, under Wallboards, in the Duration field, 
select the display time.
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You can queue up a message for display on a wallboard or series of wallboards.
ä Click Clear All Messages to remove all the messages queued up on the wallboards.

7. Select All to display it on all wallboards or Selected and the number(s) of 
the wallboards on which to display it. Check “Beep when displayed” to have 
the wallboard beep when the message is displayed.

8. Click Send > Close.
Note If you set the message to display for an indefinite amount of time, click 

Clear Message when you want to remove it.
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An on-screen alarm window is available to view all the events causing an alarm. This 
log can be filtered for each individual or group to present only information needed by 
the user.

Configure Alarms
You must first configure the alarms for each set of devices for whom you wish to set 
alarm thresholds. This is done in the Insight MIS.

Table 4 Alarm Thresholds 

Alarm Available on May Indicate

Wait Time — A call has been 
waiting too long to be answered.

Lines

Line Groups

DIDs

DID Groups

Ext. Groups

Agent 
Groups

Queues

Queue 
Groups

An imbalance of lines to extensions/agents.
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Held Time — A call which 
remains on hold for too long.

Lines

Line Groups

DIDs

DID Groups

A need for training.

Need to allocate more agents or change the 
groups’ answering priorities.

Calls Waiting — The number of 
calls waiting to be answered.

Line Groups

DIDs

DID Groups

Ext. Groups

Agent 
Groups

Queues

Queue 
Groups

An imbalance of lines to extensions/agents. 
May need to rearrange the groupings.

A training issue. Use other stats to pinpoint 
need.

Lines In Use — The number of 
lines used is near capacity.

Line Groups

DIDs

DID Groups

Ext. Groups

Agent 
Groups

Need more DIDs/lines.

Need to rearrange the way the lines and 
DIDs are grouped.

Table 4 Alarm Thresholds (continued)

Alarm Available on May Indicate
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Ring on Time — A call has been 
ringing an extension for too long.

Extensions

Agents

Possible under-staffing problem.

Could move agents from a quieter group to 
cover under-staffing.

On Call Time — A call has been 
connected for an excessive 
amount of time.

Possible training requirement. Agents may 
need to be able to take control of the call to 
get information as quickly as possible.

Discipline required.

Wrap up Time — An agent is 
taking too long to wrap up.

A training requirement. Agents may not be 
using the contact management (or other) 
application very well.

Unavailable Time — Shows when 
agent or extension has been 
unavailable for too long.

Discipline required.

Log On — Shows when an agent 
has logged on to an extension.

An unrecognized agent may have logged on 
at an extension.

Messages — Extension/Agent 
has sent a message to the 
supervisor.

Indicates a message was sent to the 
supervisor’s screen.

Idle — An agent has been idle/
available to take calls for too long 
a time.

Possible over-staffing problem.

Could move agents from a quieter group to 
cover under-staffing.

Busy — An agent has been busy 
for too long.

Possible under-staffing problem.

Could move agents from a quieter group to 
cover under-staffing.

Table 4 Alarm Thresholds (continued)

Alarm Available on May Indicate
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Terms associated with alarms are explained in Table 5.

Table 5 Statistical Analysis Threshold 

Stat. 
Analysis

Indicates Available on Reason for alarm

Wait 
Time

A call that has been waiting 
to be answered for longer 
than the acceptable wait 
time. (Affects GOS.)

Lines

Line groups

DIDs

DID groups

Queues

Queue 
Groups

May signify an imbalance of lines 
to extensions/agents.

Held 
Time 

A call which remains on hold 
for too long.

Lines

Line groups

DIDs

DID groups

Could be a need for training.

Could need to rearrange 
groupings of lines, DIDs and 
agents.

More agents may be needed.

Valid 
GOS

The level of service has 
dropped below the required 
standard (based on an 
algorithm made from a 
range of stats).

Lines

Line groups

DIDs

DID groups

Extensions

Ext. groups

Agents

Agent groups

Queues

Queue 
Groups

Summarizes the effect of a range 
of parameters. The algorithm 
uses many threshold values to 
provide a general picture of 
performance.

Acceptable GOS can be different 
for each agent or extension. (Can 
start low for new agents and 
increase the GOS over time. 
Could be linked to pay structure.)
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Ring On 
Time 
(Ring No 
Answer)

Shows when a call has been 
left ringing for longer than is 
acceptable.

Extensions

Ext. groups

Agents

Agent groups

User in conjunction with number 
of calls in the queue. The issue 
can then be addressed with 
either a discipline or it may point 
to under-staffing.

Wrap up 
Time

Shows when an agent has 
been in wrap up time for too 
long.

Could be a training need.

Held on 
Time

Calls were held at the 
extension too long before 
being transferred or 
retrieved.

Could be a training issue. Why 
are the calls being held too long? 
Is it all agents or just one or two?

Short call
Shows when an agent or 
extensions has been free for 
too long.

Extensions

Ext. groups

Agents

Agent groups

Identifies agents who may not be 
getting the best from their calls. 
Who are they ringing? Why are 
they not getting a good 
response? Do they need training 
or discipline?

Long call
Shows when calls are too 
long to be effective (affects 
GOS).

Extensions

Ext. groups

Agents

Identifies agents who take too 
long to get information required. 
Training may be needed.

Table 5 Statistical Analysis Threshold (continued)

Stat. 
Analysis

Indicates Available on Reason for alarm
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Filtering Alarms

1. From the Menu bar, click 
Setup > Alarms. The Alarms 
Configuration screen displays 
(shown right).

2. From Alarms Configuration, 
choose the appropriate button 
and check Audible Alarms if 
applicable.
Audible alarms require a 
SoundBlaster compatible card 
installed in the PC with associated multimedia drivers.

3. If you selected Edit Lines, the 
Line Alarms Configuration 
screen displays (shown right). 
Select a Filter Group from the 
drop-down menu and check any 
appropriate fields. Click OK.
Refer to Table 4 for alarm 
definitions. 
...or if you selected Edit DIDs 
or Edit Groups in any of the 
sections, a screen similar to 
the one on the right displays. 
Select a Filter Group from the 
drop-down menu and check 
the appropriate alarms. Click 
OK.
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View Alarms
View Alarms
From the Alarms Window, you can monitor alarms that have been triggered. 
Alarms appear in red on the screen (see “Indication Colors” on page 13 for a detailed 
description of screen indicator colors).

...or if you selected Edit 
Extensions or Edit Agents, a 
screen similar to the one on 
the right displays. Select a 
Filter Group from the drop-
down menu and check the 
appropriate alarms. Click OK 

4. Close the Alarms Configuration window.

ä Click the Alarms 
icon.
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Glossary

The following table contains definitions for terms used in this document.

Term Definition

ACD Automatic Call Distribution.

Account 
Code

While handling a telephone call it is possible for an extension/agent to enter 
account codes to describe the nature of the call. Up to nine digits can be entered 
per account code and 20 account codes can be entered per call.

An analysis of account code usage is provided by the Insight Reporter.

Account 
Code Group

A group of account codes. When configuring an account code group you specify 
which account codes belong to the group. (The order in which the account codes 
are listed as members of an account code group controls the order the account 
codes will be presented on a historical report associated with the group.)

Account 
Code Super 
Group

A group of account code groups. When configuring an account code super group 
you specify which account code groups belong to the super group. (The order in 
which the groups are listed as members of a super group controls the order the 
groups will be presented on a historical report associated with the super group.)

Agent 
An agent is the telephone operative who handles calls at an extension. Each Agent 
is identified by a PIN they use at the extension. The PIN should uniquely identify 
the agent if Insight is to give meaningful statistics concerning the activity of agents.
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Agent 
Contention

A situation where there are not enough agents available to take calls within the 
named agent group.

Agent Group

An agent group is a collection of agents monitored by the Insight MIS. Agents can 
belong to multiple agent groups if necessary. For each agent configured in the 
system you can make one of the groups that it belongs to its default group. In this 
case the agent inherits its configuration from the chosen default group. This facility 
allows you to configure the attributes of a set of agents by simply configuring the 
attributes of the corresponding default agent group.

Agent Super 
Group

An agent super group is a collection of agent groups monitored by the Insight MIS. 
By making reference to a single agent super group, the Insight MIS collects a set of 
agent groups together for real time display or historical reporting purposes.

Alarms 
Window

This is a separate window from the Insight MIS application window that provides a 
list of alarms in chronological order (most recent first) that are currently active in 
the system. Each item in the alarms list presents the following information:

• Type of device that is causing the alarm

• Name of the device that is causing the alarm

• Type of alarm.

Call Line 
Identity (CLI)

The Call Line Identity (CLI) of an incoming call is the telephone number of the 
caller. When the caller is using a direct exchange line the CLI will usually identify 
the caller correctly. In cases where the caller is dialing out from a PBX, the CLI will 
normally only identify the organization who made the call and not the individual 
caller.

Contention 
Report

 A contention report provides the percentage of time a variable number of 
members in a group were simultaneously free/busy. The statistics are presented 
either as non-cumulative or cumulative.

Device A line, DID number, extension or agent.

DID Group

A DID group is a collection of DID numbers monitored by the Insight MIS. DID 
numbers can belong to multiple DID groups if necessary. For each DID number 
configured in the system you can make one of the groups it belongs to its default 
group. This facility allows you to configure the attributes of a set of DID numbers by 
simply configuring the attributes of the corresponding default DID group.

Term Definition
 Insight CIX Supervisor Guide    05/05



Glossary
DID Numbers ~ GOS
DID Numbers

 A Direct Inwards Dial (DID) number is a dynamic numeric attribute assigned to a 
line on an incoming call. A DID call can be routed to groups of extensions/agents 
or to individual extensions/agents depending on how the call routing software 
within the switch has been programmed. Insight MIS can monitor in real time and 
historically the activity of inbound calls associated with DID numbers.

DID Super 
Group

A DID Super Group is a collection of DID groups monitored by the Insight MIS. By 
making reference to a single DID super group, Insight MIS collects a set of DID 
groups together for real time display or historical reporting purposes.

Exporting 
data (ASCII)

Exporting data - Use this command to export the data contained in the report 
displayed in the currently selected data window. The data is exported in comma 
delimited ASCII format. This exported data file can be read into most commercial 
spreadsheet and database programs.

Extension
An extension is the physical telephone handset at which an agent can receive 
incoming calls, make outgoing calls or handle other forms of internal telephony 
traffic.

Extension 
Contention

Not enough extensions are available to take calls within the named extension 
group.

Extension 
Group

An extension group is a collection of extensions monitored by the Insight AS. 
Extensions can belong to multiple extension groups if necessary. For each 
extension configured in the system you can make one of the groups that it belongs 
to its default group. In this case the extension inherits its configuration from the 
chosen default group. This facility allows you to configure the attributes of a set of 
extensions by simply configuring the attributes of the corresponding default 
extension group.

Extension 
Super Group

An extension super group is a collection of extension groups monitored by the 
Insight MIS. By making reference to a single extension super group, the Insight can 
quickly collect a set of extension groups together for real time display or historical 
reporting purposes.

GOS GOS - Grade of Service.
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Line

In the context of Insight MIS, a line represents either one of your external trunks 
connected to the switch being monitored or one of your network tie lines 
connecting the monitored switch to some other external switch. Each line can 
handle only one telephone call at any one time. These calls are denoted as 
incoming or outgoing calls depending on whether the call originated outside or 
inside the monitored switch.

Line 
Contention

Not enough lines are free for new calls. DIDs and DID groups. Applicable to line 
groups,

Line Group

A line group is a collection of lines monitored by the Insight ~S. Lines can belong to 
multiple line groups if necessary. For each line configured in the system you can 
make one of the groups that it belongs to its default group. In this case the line 
inherits its configuration from its chosen default group. This facility allows you to 
configure the attributes of a set of lines by simply configuring the attributes of the 
corresponding line group.

Long Call
Extension/Agent has been on a call for too long. Useful for monitoring performance 
and identifying training needs of agents.

Long Free Extension/Agent has been free to take calls for too long.

Long Queue
Too many calls are waiting to be answered in the queue group. Applicable to line 
groups, DIDs, DID groups, extension groups and agent groups.

Long Ring 
On

Extension/Agent has been ringing for too long.

Long 
Unavailable

Extension/Agent has been unavailable to take calls for too long.

Long Wait
Call has been waiting to be answered for too long. Applicable to lines, line groups, 
DIDs, DID groups, extension groups and agent groups.

Long Wrap Extension/Agent has been in wrap up for too long.

Longest Wait Length of time the longest waiting call has been waiting for.

Message A message sent to the wallboard or inView.
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MIS Management Information System — Real Time Component.

PIN Personal Identification Number — used by an agent to log on.

Real Time 
Display

Once operational, Insight MIS can provide immediate visual feedback of the 
activity on your switch.

Report 
Template

 Report Templates are used by the Insight Reporter to define the contents of a 
collated historical report. You can create any number of report templates and 
thereby produce a library of report types which can be quickly accessed when you 
collate a new historical report.

Unavailable

If an agent is logged on but needs to stop taking incoming calls temporarily, they 
can go into the unavailable (out of group) state. When the agent is ready to take 
calls again they can become available (in group) again.

Insight MIS tracks the unavailable state in real time and also provides historical 
analysis of how long agents were unavailable and how often.

Dark gray indicates the unavailable state but the text in the state column is user 
configurable. Generic unavailable and missed ACD call are standard features and 
are triggered by the agent going unavailable using their telephone handset.

Voice Mail

Extensions which have been voice mail enabled are treated slightly differently by 
the Insight M[S. When a normal extension is rung on by a line and subsequently 
connects to that line, the MIS displays the extension as being connected to the line 
and the line being connected to the extension. Statistics are then calculated 
accordingly.

Wallboards
A real time display for agents. If you have purchased the wallboard option, you can 
use the AS to display real time call status and statistics parameters on up to six 
wallboards simultaneously. You can also send messages to selected wallboards.
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Wrap Up

When an agent is about to finish a call, they can choose to go into wrap-up before 
the call is terminated. This will leave the agent in the wrap-up state thereby 
stopping further incoming calls being targeted at the agent. While in wrap-up the 
agent can do any clerical work associated with the call just taken. Once finished 
the agent can leave the wrap up state so that they are ready to take further 
incoming calls.

Insight MIS tracks wrap up in real time and also provides historical analysis of how 
much wrap up time each call required on a per agent basis.
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extension, 26, 69
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F
features, 2
filters, 29
forecasting, 49
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reports, 39

G
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H
held on time, 63
held time, 60, 62

I
icons, 3
Insight plus, 2
interval call statistics, 16

L
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window, 23
line, 70
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call, 63, 70
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unavailable, 70
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M
main menu, 3
messages, 57, 70
MIS, 71

N
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Insight CIX Supervisor Guide    05/05



Index
S ~ W
reports, 25
account code, 38
agent/extension traffic, 33
compile, 44
concepts and terminology, 25
contention, 36
distribution, 36
edit contents, 41
event, 32
export, 45
filter contents, 43
filters, 29
forecasting, 38
line traffic, 34
MIS, 46
print, 44
scheduling, 31
template, 40
templates, 31
types, 27
utilization, 35

ring on
time, 61, 63

S
shifts, 27
short call, 63
statistics

agent, 17
daily call, 16
interval call, 16
real time, 16

status
colors, 13

T
template

report, 40
toolbars, 4

U
unavailable, 61, 71

V
valid GOS, 62
voice mail, 71

W
wait time, 59, 62

graph, 19
wallboards, 49, 71

automatic parameter layout, 54
change fonts, 55
configuring, 49
edit items, 53
messages, 56
queue messages, 57
schedule, 52
template

configure, 49
create, 50

wrap up
time, 61, 63, 72
Insight CIX Supervisor Guide    05/05 75



Index
W ~ W

76
 Insight CIX Supervisor Guide    05/05


	Title Page
	Publication Information
	Toshiba DSD License Agreement
	Contents
	Introduction
	Organization
	Conventions
	Related Documents and Media
	CD-ROMs


	The Grand Tour 1
	Insight Features
	Insight Plus Features
	Insight MIS Real Time Client
	Menu Bar
	Toolbar

	Wallboards
	Reports
	Toolbar

	Configurator

	Real Time Displays 2
	Create Real Time Displays
	Composite Screen Layout

	Agent Status Window
	Create New Agent Status Window
	Configure Agent Status Window

	Real Time Statistics
	Set Real Time Statistics

	Agent Statistics
	Create New Agent Statistics Window
	Configure Agent Statistics Window

	Wait Time Graph
	Create Wait Time Graph Window
	Change Wait Time Graph Properties

	Calls in Queue Graph (Insight Plus Only)
	Creating Calls in Queue Graph
	Configuring Calls in Queue Graph

	Large Character Window
	Create Large Character Window
	Configure Large Character Window
	Duplicate Large Character Window

	Alarms

	Reports 3
	Report Concepts and Terminology
	Devices
	Shifts
	Types of Reports
	Filters
	Templates
	Scheduling

	Reports
	Event Reports
	Traffic Reports for Agents or Extensions
	Traffic Reports for Lines
	Utilization Reports
	Contention Reports (Insight Plus Only)
	Distribution Reports
	Account Code Reports

	Forecasting
	Forecasting Report
	Forecasting Profile Report

	Create Report Template
	Edit Report Contents
	Filter Report Contents (optional)
	Create Report
	Export Report
	Using MIS Reports to Improve Performance
	Abandoned Calls and Long Waits
	Complaints of Busy Signals
	Unexpected Out-of-hours Customer Demand
	Complaints About Too Many Transfers


	Wallboards 4
	Create Wallboards
	Edit Wallboard Items
	Automatic Parameter Layout
	Change Fonts
	Create Wallboard Message
	Queue Messages

	Alarms 5
	Configure Alarms
	Filtering Alarms

	View Alarms

	Glossary
	Index

